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  v.4.5 Easy Concrete Detailing   (ECD)نرم افزار ترسیم جزئیات سازي هاي بتنی

نرم افزاري جهت ترسیم جزئیات سازه هاي بتنی میباشد که با استفاده از خروجی هاي نرم   ECDنرم افزار 
به صورت خودکار تمامی جزئیات میلگرد گذاري و خاموت گذاري و مقاطع تیرها و ستون ها را  Etabsافزار 

 dxfیا  dwgواه درون محیط برنامه ترسیم نموده و فایل هاي خروجی را با مقیاس مورد نظر و با فرمت دلخ
  آماده می نماید .

  ویژگی ها 
  ورود داده ها با استفاده از خروجیEtabs 

 ترسیم جزئیات ستون گذاري و تیر ریزي 

  ستون هاطولی و عرضی ترسیم جزئیات مقاطع 

  تیر هاي سرتاسري مقاطع طولی و عرضی ترسیم جزئیات 

  آرماتور گذاري مقاطعقابلیت معرفی آرماتورهاي سرتاسري و استفاده از آنها در 

  قابلیت معرفی آرماتور خاموت و فواصل خاموت گذاري در تیر ها و ستون ها و تعیین آرماتور گذاري در ناحیه
 ویژه

 و آئین نامه آبا هخاموت گذاري خودکار تیر ها و ستون ها بر اساس قابلیت شکل پذیري ساز 

  و ترسیم آنهاش دستی بلیت ویرایابا قتشخیص تیرهاي سرتاسري به صورت خودکار 

  تعریف نحوه آرماتور گذاري در تیر ها بر اساس روابط آیین نامه اي قابلیت 

 تعیین خودکار میزان آرماتور هاي تقویتی مورد نیاز در تیر ها 

  به صورت خودکارتعیین تعداد آرماتور هاي طولی  در مقاطع تیر و ستون 

  و مقیاس مقاطع هنگام ترسیم عناصرقابلیت تعریف مقیاس ترسیم در جهت عمودي و افقی 

 قابلیت تعیین رنگ دلخواه جهت ترسیم اجزاي مختلف تیرها و ستون ها و مقاطع آنها 

  ترسیم تمام جزئیات در محیط برنامه با قابلیت ویرایش اجزاي ترسیمی بدون نیاز به نرم افزار هاي جانبی مانند
 وکدات

 ) قابلیت ذخیره ترسیمات با فرمت فایل هاي اتوکدdwg , dxf( 

  نرم افزار طقابلیت پرینت گرفتن از خروجی ها از درون محی 

 تیپ بندي خودکار ستون ها 

  در همه حالت ها ترسیم دیوار هاي برشی)Simplified ,Uniform,General( 

  قابلیت کنترل خطاهاي موجود در فایل خروجیEtabs 

  کنترل میزان مجاز نسبت تنش ها 

 نکنترل میزان حداکثر و حداقل آرماتور مجاز مقاطع بر اساس آئین نامه ایرا  
 قابلیت تغییر زبان نرم افزار به فارسی یا انگلیسی  
 محاسبه حجم بتن در تیر ها و ستون ها  
 قابلیت محاسبه و ترسیم لیست میلگرد ها و جدول میلگرد گذاري و تهیه لیستوفر 

 راحی و ترسیم پلهط 
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ی ݵ нعا ه  ՏٌО  

پنجره اصـلی تشـکیل    یکاز Easy Concrete Detailing (ECD) نرم افزار 
 شده است .

ترسیمات خروجـی هـا و ذخیـره    کلیه ورود اطلاعات مورد نیاز و اجراي فرامین و 
  .درون محیط اي سی دي صورت میگیرند ترسیمات و تهیه چاپ از ترسیمات 

  

  
  

  ترسیمی از منوي سمت چپ در دسترس کاربر میباشند.تمامی قابلیت هاي 
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را در پــورت  Tinyusbقفــل ســخت افــزاري  ECDقبــل از بــاز کــردن برنامــه 
Usb . کامپیوتر وارد کنید  

  
  

  :  Etabsاز  ECDخروجی گرفتن از داده هاي ورودي نرم افزار 
  

، واحـد   Etabsقبل از شروع عملیات گـرفتن خروجـی از نـرم افـزار      
  تغییر دهید .  kgf-cmرا به  Etabsبرنامه 

  
  

پروژه هدف ما باید دو فایل حـاوي اطلاعـات پـروژه بـا      Designپس از آنالیز و 
 Etabsرا از برنامـه   txt. و فایل حاوي اطلاعات طراحی با فرمـت   e2k.فرمت 

  استخراج کنیم .
  دنبال کنید : Etabsبراي این کار مسیر هاي زیر را در برنامه 

File >Export> Save Model as ETABS .e2k Text File…  
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 خروجی فایل حاوي اطلاعات طراحی تیرها و ستون ها:
File > Print Tables > Concrete Frame Design 
 

 
 

  خروجی فایل حاوي اطلاعات طراحی دیوار هاي برشی :
پس از معرفی و طراحی دیوار هاي برشی فایل متنی طراحی دیـوار هـاي برشـی    

  را آماده مینماییم.  ECDجهت ورود به نرم افزار 
واحـد هـاي    دیـوار برشـی ,   قبل از خروجی گرفتن از اطلاعات مربوط به طراحی

  تغییر میدهیم .  currentمربوط به خروجی داده ها را 
  

  دنبال کنید : Etabsرا در برنامه براي این کار مسیر هاي زیر 
Options>ShearWallDesign 
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 currentرا بـه  Rebar /LengthUnits  و  RebarUnitsسپس واحد هـاي  

جهـت تهیـه ترسـیمات     kgf/cmاز واحـد   ECDتغییر میـدهیم تـا نـرم افـزار     
  استفاده نماید .

  

 
  

فایـل متنـی خروجـی را تهیـه و ذخیـره       Etabsسپس از مسیر زیر از نرم افزار 
  مینماییم .

  
File > Print Tables >Shear Wall Design 
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 Etabs2013 یخروج
با  یخروج یمتن لیفا نیشیپ يهمانند نسخه ها  Etabs v13 نکهیبا توجه به ا

 ECDنرم افزار  يها برا يورود ينحوه آماده ساز کندیارائه نم  txtفرمت 
  .باشدیمتفاوت م

 ریز بیسازه به ترت یو طراح لیپس از تحل Etabs2013از  یخروج هیته جهت
 :دیاقدام کن

 
 ـفا ياز منـو  را انتخـاب    Export to Accessو سـپس     Export نـه یگز لی

 : دیینما
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ــاز شــده هماننــد شــکل ز ــهیگز ریــدر پنجــره ب و  project settings  يهــا ن
Concrete Design  یبرش ـ واریو در صورت وجود د Shear wall Design 

 :دیرا علامت دار کن

 
 :دییانتخاب نما یخروج يرا جهت نوع واحد ها kg , cm يسپس واحد ها
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 ای 2003شده را با فرمت  جادیاکسس ا لیکه نسخه فا دیدار ازین يدر مرحله بعد
اکسس آنرا باز نموده و مطـابق   یخروج لیفا رهی. پس از ذخدیینما رهیذخ نترییپا

 :دیینما رهیتر ذخ نییشکل آنرا با فرمت پا

 
 

را  میترس اتیو عمل دیکن یمعرف ECDرا به  mdbو   E2k لیدر مرحله آخر فا
 .دیانجام ده
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 ورود داده ها : 
و کلیک بر روي دکمه ورود داده هـا در   ECDپس از  تهیه ورودي هاي نرم افزار 

مسیري را که فایل پروژه مـورد نظـر را   Browseفرم زیر با کلیک بر روي دکمه 
کلیـک   okذخیره کرده ایم انتخاب و آنها را بـه برنامـه معرفـی میکنـیم و روي     

  میکنیم .
  

  
  

نامـه  و واحد مورد استفاده و آئین  Etabsپس از وارد کردن داده ها ورژن برنامه 
مورد استفاده در طراحی ، در نوار ابزار پایین پنجره اصلی برنامه قابل مشاهده می 

  باشند .
آیین نامه ها و واحد هاي انتخاب شده جهت محاسبات دیوار برشـی پـس از بـاز    

  کردن پنجره مربوط به دیوار هاي برشی قابل مشاهده میباشند .
 

دیـوار برشـی باشـد گزینـه     در صورتی که فایل مدل سازه فاقـد مـدل   
  غیر فعال خواهد ماند .» خروجی دیوار برشی«مربوط به 
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  ترسیم پله:
  با کلیک روي ترسیم پله پنجره تنظیمات مربوط به پله باز می شود .

تمامی اندازه گذاري ها و تنظیمات مربوط به میلگرد گذاري در روي شـکل قابـل   
تعـداد پلـه   یر عرض پله، ارتفاع پلـه،  تنظیم میباشند. مشخصات و اندازه هایی نظ

  ها، اندازه کف پله ها، ضخامت دال بتنی و .... در پنجره اندازه ها تعیین میگردند. 
در قسمت میلگرد ها دو روش براي میلگرد گذاري وجود دارد کـه در روي شـکل   
قابل مشاهده است.تعداد و فاصله میلگرد ها ي طولی و عرضی نیز در این قسـمت  

  پله ترسیم شده قابل مشاهده است. okتعیین میگردند. با کلیک بر روي گزینه 
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  ترسیم ستون ها :
  پنجره تنظیمات مربوط به ستون ها باز می شود .با کلیک روي ترسیم ستون ها 

  در قسمت مقیاس ، مقیاس هاي مورد نظر جهت ترسیم انتخاب می شوند .
در راسـتاي افقـی و   ضریب فاصله ها به علت در نظـر گـرفتن مقیاسـی متفـاوت     

  می باشند تا فواصل مشخص تر باشند.هنگام ترسیم عمودي 
علامت دار باشد؛ جدول میلگـرد   "میلگرد هاترسیم لیست "در صورتی که گزینه 

  گذاري و لیستوفر میلگرد ها ترسیم خواهد شد.
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  تیپ بندي ستون ها :
گزینه تیپ بندي ستون ها در پایین صفحه مربوط به مقیاس قرار دارد و بصـورت  

  پیش فرض انتخاب شده است .
سـتون هـا را در   به صورت خودکار  ECDبا علامت دار بودن این گزینه نرم افزار 

تیپ بندي نمـوده و محـل آنهـا را در     Checkو یا  Designحالت هاي مختلف 
  پلان ستون گذاري مشخص مینماید.

در صورتی که گزینه تیپ بندي خودکار ستون ها علامت دار نباشد تمامی ستون 
 هاي موجود ترسیم خواهند شد .

  
ستون ها قابل مشاهده پلان تیپ بندي ستون ها پس از مرحله ترسیم 

 مشاهده میباشد.
  

در قسمت رنگ ها ، رنگ هاي  مورد نظر براي المان ها جهت ترسیم و همچنـین  
  ضخامت خطوط المان ها ، انتخاب می شوند .
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در قسمت اندازه فونتها ضریب مربوط به اندازه فونت ها تعریف میشود . بـا تغییـر   
 رب میگردد.این ضریب اندازه فونت ها در مقیاس وارد شده ض

  
در قسمت آرماتور هاي اصلی و برشـی علامـت آرمـاتور هـاي برشـی در      

  ترسیمات قابل تعییر میباشد.
  
  

با کلیک بر روي علامت ذخیره که در پایین فـرم هـا موجـود اسـت کلیـه      
  تغییرات اعمال شده جهت استفاده در پروژهاي بعدي ذخیره میگردند.
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ستون ها  و همچنین ضخامت پی قابل تغییر می در قسمت طول ها ، طول ریشه 
 باشند .

 
  قابل تعریف می باشد : روش  سهبه  Overlapطول 

  .به صورت مستقیم -
 به صورت مضربی از ارتفاع ستون . -
براي قطر هاي کوچکتر و  65و  52به صورت ضریبی از قطر میلگرد ها .(ضرایب -

ــر از  ــاس   20mmبزرگت ــر اس  fy=4000 kg/cm2و  f’c=210 kg/cm2ب
  محاسبه شده اند.)
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  طول خم :

قطـر میلگـرد هـا    درجه بر اساس  135درجه و  90طول مورد نیاز براي خم هاي 
  معرفی میگردند.

  
  

در قسمت کاور نحوه تعیین کاور بـر اسـاس خروجـی هـاي ایتـبس و همچنـین       
  ضرایب رند کردن طول ها قابل ویرایش میباشند.
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 نامه اي :ضوابط آئین 
در این قسمت نحوه خاموت گذاري بر اساس ضوابط آئیین نامـه اي انتخـاب مـی    

  شوند .
زبانـه  » رعایت پارامتر هاي معرفی شـده توسـط کـاربر   «در صورت انتخاب گزینه 

آخر(خاموت ها ) فعال شده و اطلاعات وارد شده توسط کاربر بـه عنـوان پـارامتر    
  رند .هاي ترسیم مورد استفاده قرار می گی

ضوابط خاموت گذاري بر اساس شکل پذیري مطابق فصـل بیسـتم مبحـث نهـم     
  می باشند .» ضوابط ویژه براي طراحی در برابر زلزله «مقررات ملی ساختمان 

  
 

  قطر خاموت مورد استفاده نیز در این قسمت معرفی می شود .
  گزینه مربوط به قطر آرماتور هاي اصلی :

انجـام   Designدر حالـت   Etabsدر صورتی که طراحی ستون ها در نرم افزار 
کـه  Etabsبه صورت خودکار از قطر هاي موجود در  ECDشده باشد ، نرم افزار 

جهت تعیین تعداد آرماتورهـا و تیـپ   در قسمت معرفی مقاطع معرفی می شوند ، 
  بندي ستون ها استفاده مینماید.
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باشیم نتایج ترسیمی با قطر هاي جدید انجام گیرد بـا   در صورتی که قصد داشته

کلیک بر روي دکمه قطر آرماتورهاي اصلی قادر خواهیم بود آرماتور و یا مجموعه 
آرماتور هاي جدید را معرفی کرده و عملیات ترسیم را با آرماتورهاي معرفی شـده  

  انجام دهیم .
  

انجـام شـده باشـد     Checkدر صورتی که طراحی ستون ها در حالـت  
ثیري بـر نتـایج خروجـی نخواهـد     انتخاب آرماتورها در ایـن قسـمت تـا   

  .داشت
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  انتخاب آرماتورها :

براي استفاده در سـتون   ECDجهت معرفی آرماتور هاي مورد استفاده نرم افزار 
قرار داشته باشـند )    Designبر روي حالت  Etabsها (هنگامی که در نرم افزار 

  استفاده می شود.
 

توجه : براي دسترسی به پنجره انتخاب آرماتور هـاي اصـلی در نسـخه    
، در قسـمت  »  قطـر آرمـاتور اصـلی   «، روي دکمـه   ECDهاي جدیـد  

  ضوابط آئیین نامه اي کلیک کنید . 
 

  
  

، قابـل اضـافه    -و  +با انتخاب هر یک از آرماتورها و کلیک بر روي دکمـه هـاي   
  شدن و حذف می باشند .

 
 جهت اضافه کردن آرماتور هاي جدید باید از منوي         

Option > preferences > Reinforcement Bar Sizes… 
  استفاده کنیم . Etabsدر          
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  خاموت گذاري توسط کاربر :

ستون ، وسط ستون و در قسمت خاموت ها فاصله خاموت ها در سه ناحیه بالاي 
  پایین ستون قابل تعریف میباشند .

یم و همچنـین بـه صـورت    قهمچنین طول خاموت گـذاري بـه دو صـورت مسـت    
  مضربی نسبت به ارتفاع ستون قابل تعریف می باشند . 
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در نرم افزار  Coverعدد وارد شده به عنوان :  Coverتوضیح در مورد 
Etabs       ، در فاصله مرکز میلگرد هاي طـولی تـا پشـت مقطـع میباشـد

تا پشت خاموت به عنوان کـاور در  فاصله  ECDدر نرم افزار صورتی که 
به صورت خودکار نصـف قطـر میلگـرد     ECDنرم افزار نظر گرفته شود 

کسر مینمایـد   Etabsهاي طولی و قطر خاموت را از عدد وارد شده در 
در   Coverلگــرد هــا را بــه عنــوان و ضــخامت پوشــش بــتن روي می

 ترسیمات نمایش می دهد.
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  ترسیم تیر ها :
  با کلیک روي ترسیم تیر ها پنجره تنظیمات مربوط به تیر ها باز می شود .

مقیاس هاي مورد نظر جهت ترسـیم  روش ترسیم تیرها و  ، تنظیمات در قسمت 
  انتخاب می شوند .

  : پلانو  آرماتور گذاري تیر ها در مقاطع طولی ،ترسیم پلان تیر ریزي
مقاطع طـولی تمـامی   ،برشـی دیوار هـاي   وقعیتمیر ریزي و پلان ت ترسیم ازس پ

و پـلان   میلگـرد هـاي اصـلی و تقـویتی     میشـود.   رسـیم تو مقاطع عرضی تیرها 
به تفکیک طبقات بر روي پلان در تیر ها نمـایش داده میشـوند و    خاموت گذاري

واهد شد. مقاطع عرضی تیر ها نیـز  خبه تعداد طبقات پلان آرماتور گذاري ترسیم 
   به صورت جداگانه ترسیم خواهند شد.پس از تیپ بندي 

لیست میگرد ها نیز تنها در صورتی که این گزینه انتخاب شده باشد فعال  ترسیم
  میگردد.

  مقیاس :
ضریب فاصله ها به علت در نظـر گـرفتن مقیاسـی متفـاوت در راسـتاي افقـی و       

  عمودي هنگام ترسیم می باشند تا فواصل مشخص تر باشند.
  جدول میلگرد گذاري:

علامت دار باشد؛ جدول میلگـرد   "میلگرد هاترسیم لیست "در صورتی که گزینه 
  گذاري و لیستوفر میلگرد ها ترسیم خواهد شد.
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در قسمت رنگ ها ، رنگ هاي  مورد نظر براي المان ها جهت ترسیم و همچنـین  
  می شوند .ضخامت خطوط المان ها ، انتخاب 

  
  :ترسیم آرماتور گونه

 "تنظیمـات "تنظیمات مربوط به ترسیم آرماتور گونه در ترسیم تیرها و سـربرگ  
قرار گرفته است. در کلیه تیرهاي با عمق بزرگتر از مقدار وارد شده توسط کاربر ، 

  آرماتور گونه به صورت خودکار هنگام ترسیم مقاطع نمایش داده میشود.
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. بـا تغییـر    در قسمت اندازه فونتها ضریب مربوط به اندازه فونت ها تعریف میشود

  این ضریب اندازه فونت ها در مقیاس وارد شده ضرب میگردد.
 

  قسمت آرماتورهاي سراسري :
تعیین روش آرماتورگذاري توسط کـاربر ،بـر اسـاس آئـین     از پس   ECDبرنامه  

  نامه ایران  آرماتور مورد نیاز تیر ها را به صورت خود کار تعیین می کند .
 سري:روش هاي معرفی  آرماتور سرا

در ابتدا کاربر باید سطح مقطع حداقل آرماتور را براي بالا و پایین تیر هـا معرفـی   
  کند .

در این صورت نرم افزار آرماتور معرفی شده را به عنوان حداقل آرماتور مورد نیـاز  
  در مقطع در نظر می گیرد .
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براي معرفی آرماتور ها می توانید تعداد و قطر آرماتور را معرفی کنید تا 
سطح مقطع محاسبه شود ، یا بصورت مستقیم سطح مقطع حد اقـل را  

  معرفی کنید . 
  

  
  

 روش صورت می گیرد :  چهارتعیین آرماتور سراسري توسط نرم افزار به 
  در نظر نگرفتن آرماتور تقویتی براي وسط :-1

و دریافـت اطلاعـات    Etabs، بر اساس خروجی هاي  ECDدر این روش برنامه 
مربوط به سطح مقطع فولاد مورد نیاز براي هر تیر ، آرماتور هاي تیر سراسـري را  
به نوعی تعیین میکند که در وسط هیچ کدام از تیر ها نیـاز بـه آرمـاتور تقـویتی     

تیر ها به سـتون هـا در نظـر     نباشد و تمامی آرماتور هاي تقویتی در محل اتصال
  گرفته شوند . 
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  . س آیین نامه ایران تعیین میگرددطول مورد نیاز آرماتور هاي تقویتی نیز بر اسا
  قرار دادن آرماتور حداقل براي آرماتور سراسري :-2

و  Fyبر اساس آیین نامه ایران وبا استفاده از  مقدار  ECDدر این روش نرم افزار 
رماتور حداقل مورد نیاز براي تیر ها را تعیین می کند و هر جا سطح مقطع تیر ، آ

که مقدار آرماتور مورد نیاز بیشتر از مقدار حداقل باشد از آرماتور تقویتی استفاده 
  می کند .

  درصدي از آرماتور ماکزیمم به عنوان آرماتور سراسري : ندرنظر گرفت -3
تور محاسـبه شـده در مقطـع را    مقدار ماکزیمم آرما ECDدر این روش نرم افزار 

حساب کرده و آنرا در درصد عدد معرفی شده ضـرب مینمایـد و آنـرا بـه عنـوان      
آرماتور سراسري قرار داده و سپس در هر جا که مقدار آرماتور مورد نیاز بـیش از  

 آرماتور سراسري باشد از آرماتور تقویتی استفاده خواهد کرد .
  ط کاربر :تعیین آرماتور هاي سراسري توس -4

در این روش در قسمت تیرهاي سرتاسري قسـمتی بـراي تعیـین تعـداد آرمـاتور      
تعداد و قطـر وارد شـده را    ECDسراسري توسط کاربر ایجاد میگردد و نرم افزار 
ورت خودکار آرماتور هاي تقویتی به عنوان آرماتور سراسري در نظر گرفته و به ص

  مورد نیاز را محاسبه و ترسیم میکند .
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  روش هاي محاسبه آرماتور هاي تقویتی در اي سی دي:
پس از مشخص نمودن مقدار آرماتور هاي اصلی، مقدار آرماتور هـاي تقـویتی بـر    
اساس اختلاف بین آرماتور مورد نیاز و آرماتور اصلی محاسبه میگـردد و بـه سـه    

  روش مختلف قابل نمایش در ترسیمات میباشد.
  

  روش اول : 
، تعداد آرماتور مورد نیاز  "محاسبه خودکار آرماتور هاي تقویتی"گزینه با انتخاب 

بر اساس قطر معرفی شده توسـط کـاربر در هـر طبقـه محاسـبه و در ترسـیمات       
  نمایش داده میشود.

  روش دوم:
، مسـاحت مـورد نیـاز بـر روي      "درج مساحت آرماتور هـاي تقـویتی  "با انتخاب 

  ترسیمات درج میگردد.
  روش سوم:

، جدول بازه هاي مختلـف   "درج مقادیر تعریف شده توسط کابر"انتخاب گزینه با 
  مساحت و میزان آرماتور ها نمایان میگردد. 

در این جدول بازه هاي مختلف سطح مقطع و میزان آرماتور مـورد نیـاز ، توسـط    
کاربر قابل تعریف میباشد و نرم افزار اي سی دي با توجه بـه بـازه هـاي موجـود     

  رماتور تقویتی را در ترسیمات محاسبه و درج میکند.میزان آ
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به عنوان مثال مطابق جدول بالا در صورتی که سطح مقطـع تقـویتی مـورد نیـاز     

ســانتی متــر مربــع باشــد آرمــاتور تقــویتی در ترســیمات        9الــی  6بــین 
[2φ18+1φ16]   سانتی متـر مربـع    4.4الی  3.3خواهد بود و براي[2 φ 16] 
  منظور خواهد شد.

  

نوع قطـر مختلـف قابـل تعریـف      2توجه نمایید که براي هر بازه حداکثر   
میباشد و در صورتی که سطح مقطع آرماتور تقویتی مورد نیـاز در هـیچ بـازه اي    
تعریف شده نباشد نرم افزار اي سی دي مساحت مورد نیاز براي آرمـاتور تقـویتی   

  را در ترسیمات درج خواهد نمود. 
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  طول خم :
درجه بر اساس قطـر میلگـرد هـا     135درجه و  90طول مورد نیاز براي خم هاي 

  معرفی میگردند.
  

  
  

برابـر قطـر    9براي مثال در شکل بالا براي خاموت ها بیشترین مقـدار  
  درجه مورد استفاده قرار میگیرد. 135میلیمتر در خم  75میلگرد و 

  
  گذاري :ضوابط آئین نامه در  خاموت 

در این قسمت نحوه خاموت گذاري بر اساس ضوابط آئیین نامـه اي انتخـاب مـی    
 شوند .
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زبانـه  » رعایت پارامتر هاي معرفی شـده توسـط کـاربر   «در صورت انتخاب گزینه 
آخر(خاموت ها ) فعال شده و اطلاعات وارد شده توسط کاربر بـه عنـوان پـارامتر    

  د .هاي ترسیم مورد استفاده قرار می گیرن
ضوابط خاموت گذاري بر اساس شکل پذیري مطابق فصـل بیسـتم مبحـث نهـم     

  می باشند .» ضوابط ویژه براي طراحی در برابر زلزله «مقررات ملی ساختمان 
  

  
 

 قطر خاموت مورد استفاده نیز در این قسمت قابل معرفی می باشد .
وسـط تیـر  و    در قسمت خاموت ها فاصله خاموت ها در سه ناحیه ابتداي تیـر  ، 

 انتهاي تیر قابل تعریف میباشند .
 

سـه روش قابـل معرفـی مـی باشـد  ( خـاموت       همچنین طول خاموت گذاري به 
  گذاري در ناحیه بحرانی)
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 فاصله اي که باید خاموت گذاري شود معرفی می شود .یم قصورت مستبه  -1
 نسبت به طول تیر که مضربی از عدد وارد شده در طول تیر می باشد . -2
نسبت به ارتفاع مقطع که از حاصلضرب عـدد وارد شـده در ارتفـاع مقطـع      -3

  بدست می آید .
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  ویرایش دستی تیر هاي سراسري :

  
در این قسمت شما قادر خواهید بود که راستاي تیر هاي سراسري را که توسط 

دي به صورت خودکـار تشـخیص داده شـده اسـت را ویـرایش      -سی-نرم افزار اي
  کنید .

تیر هاي هم راستا و غیر هم راستایی که از نظر اجرایـی بـه عنـوان تیـر     تمامی 
سراسري تعریف میگردند به صورت خودکار توسط نرم افزار اي سی دي تشخیص 

  داده میشوند و لیبل بندي میگرند.
  

با راست کلیک کردن روي جدول تیر هاي سراسري منویی ظـاهر میشـود کـه    
حذف کرده , ردیـف جدیـد ایجـاد کنیـد , و      می توانید از طریق آن یک ردیف را

همچنین ستون آخر را حذف کرده و یا یک ستون جدید به آخر ستون ها اضـافه  
 کنید.
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ویرایش هاي صـورت گرفتـه در تیرهـا    »  ذخیره ترتیب تیرها«با انتخاب گزینه 
قابل ذخیره براي بازیابی هاي بعدي خواهند بود . فایل ایجاد شده در این قسمت 

فراخـوانی ترتیـب   «نرم افزار اکسل نیز قابل ویرایش میباشد و با انتخاب گزینه با 
  فایل ذخیره شده قابل بازیابی میباشد .» تیرها

  
تمامی این قابلیت ها با استفاده از ابزار هاي موجود در بالاي جدول تیر 

  هاي سراسري نیز در دسترس میباشند.
  هر ردیف از جدول به عنوان یک تیر سراسري در نظر گرفته میشود. : 1توجه
اگر نام تیري را که وارد کرده اید در تیر ها موجود نباشد , نرم افـزار بـه    :2توجه

  . صورت خودکار آن را نادیده گرفته و تیر بعدي مورد بررسی قرار میدهد
  

مورد استفاده در صلی در قسمت تعیین آرماتور هاي سراسري , قطر آرماتور هاي ا
و تقـویتی بـه میلیمتـر بـراي هـر طبقـه وارد       بالاي هر مقطع و پایین هر مقطـع  

  میشوند .

  
  

فعال کردن قابلیت ویـرایش دسـتی   «توجه:براي فعال شدن این قابلیت ها گزینه 
  باید فعال باشد .» تیر هاي سراسري
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  ترسیم دیوار برشی :

مـدل و   Etabsانواع دیوار برشی که با روش هاي مختلف در  ECDدر نرم افزار 
  محاسبه میشوند قابل ترسیم میباشد .

بر حسب اینکه بـا   ECDنحوه محاسبه و ترسیم مقاطع دیوار برشی در نرم افزار 
در حالـت   Generalو یـا    Simplified  ،Uniform کـدامیک از روش هـاي  

Design  یاCheck  درEtabs . مدل و محاسبه شده باشند متفاوت می باشد  
تفاوت موجود در آرایش آرماتور ها و ترسیم مقاطع عرضی و قطـر آرمـاتور مـورد    

  استفاده است.
  

، نتـایج بهتـري در    Etabsرعایت نکات زیر در هنگام مدل کردن دیوار برشی در 
  در پی خواهد داشت : ECDهنگام ترسیم با نرم افزار 

  براي هر دیوار بایدPier     معرفی شود ، زیرا خروجی هاي دیـوار برشـی بـر
 Etabsباشند توسط  Pierها میباشند و دیوار هایی که فاقد  Pierحسب 

  محاسبه نخواهند شد.
  پیشنهاد میگردد که هنگام معرفی مقاطع دیوار در SectionDesigner 

آرایش یکسان (فاصله هـاي  دو طرف دیوار از آرماتور هایی با قطر برابر و  در
برابر ) استفاده گردد ؛ در غیر اینصورت حالـت بحرانـی تـر (قطـر بیشـتر و      
فاصله کمتر ) به عنوان آرماتور گذاري براي مقـاطع دیـوار در نظـر گرفتـه     

  خواهد شد .
  واحد ها هنگام خروجی کنترل گردند ،واحدcurrent  براي دیوار برشی و

kg  وcm  میباشد . ( به قسمت تهیه فایل خروجی هنگام خروجی ضروري
  مراجعه شود ) Etabsاز 
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 پنجره دیوار  برشی آیین نامه اي که دیوار بـا آن طراحـی    در قسمت پایین
  که مشاهده میشود .  (current)شده و واحد خروجی ها

  
نحـوه  مربوط به مقیاس و رنگ ها هماننـد تیـر هـا و سـتون هـا       هاي در قسمت

  تنظیم میگردد.نمایش ترسیمات 
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در صورتی که دیوار در حالت طراحی باشد با معرفی قطر آرمـاتور هـاي   

بـر اسـاس خروجـی هـاي      ECDطولی و برشی توسط کاربر ، نرم افزار 
Etabs     فاصله مورد نیاز بین آرماتورها را به صـورت خودکـار محاسـبه

مینماید و با فاصله مجاز وارد شده توسط کاربر مقایسه مینماید و فاصله 
  نهایی را تعیین نموده و آرماتور گذاري را در مقاطع ترسیم مینماید . 
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در حالـت   جدول زیر در حالتی کـه دیـوار  مربوط به آرماتور طولی توجه : مقادیر 
Check  . باشد استفاده نخواهد شد  

  
ــوار هنگــام مــدل کــردن    ــوع دی ــوار برشــی ن پــس از ترســیم مقــاطع دی

)Simplified  ،Uniform    و یـاGeneral  حالـت ، (Check    و یـا
Design   و همچنینPier    دیوارها در هنگام ترسیم مقـاطع نشـان داده

  خواهند شد .
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  ابزار :
روي دکمه ابزار منوي امکانات ظاهر خواهد شد که با کلیـک بـر روي   با کلیک بر 

  ایتم مورد نظر دستور اجرا خواهد شد.

قابـل دسـترس    Check Errorsمنوي کنترل خطاها نیز از این قسمت بـا نـام   
خطاهاي موجود به همـراه نـام مقطـع، طبقـه، و شـرح خطـا نمـایش داده        است. 

  خواهند شد . 

و میـزان نسـبت تـنش هـا و میـزان       Etabsخروجـی   خطاهاي موجود در فایـل 
محدودیت آرماتورها در مقاطع و حداکثر و حداقل سـطح مقطـع مجـاز  آرمـاتور     

 نسبت به  مقاطع در این قسمت بررسی میگردند .

  

لازم است در صورت وجود خطا پـس از برسـی و رفـع خطـاي موجـود      
 نسبت به تریسمات اقدام گردد.

توجه: حداکثر تعداد کاراکترهایی که در نامگذاري مقاطع تیـر و سـتون   
حـرف   7هـا    combo حـرف و در   9باید مورد استفاده قـرار گیـرد   

  میباشد. 
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Toolbarترسیمات: 

 

Drawing Open:       جهت باز کردن فایل ترسـیمی اسـت کـه قـبلا ذخیـره
  کرده ایم.

Save Drawing:        جهت ذخیـره فایـل ترسـیمی میباشـد کـه در قسـمت
Save as type  بود.نوع فرمت خروجی آن قابل تنظیم خواهد  

  :مدریت لایه ها

نرم افزار اي سی دي المان هاي متفـاوت را در لایـه هـاي مختلـف ترسـیم      
مینماید. براي کنترل لایه ها با کلیک بـر روي علامـت لایـه از منـوي بـالا،      
لیست لایه هاي مختلف موجود در ترسیم نمایش داده میشود. با کلیـک بـر   

  کنار هر لایه ، لایه مورد نظر خاموش و یا روشن خواهد شد. روي چراغ
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Print Drawingچاپ کردن اشکال ترسیمی از این گزینه اسـتفاده   : جهت
  میشود.

  
نام چاپگر ،   Changeبا کلیک بر روي دکمه  Device Print در قسمت 

  قابل تنظیم خواهند بود.  بودن آن هنگام چاپسایز کاغذ و افقی یا عمودي 
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 و سپس کلیک بر روي دکمه  Windowو  Area Print در قسمت 
Pick  . محدوده پرینت قابل انتخاب خواهد بود  

  مقیاس تنظیم میشود . Scale Printدر قسمت  
  نوشته میشود.  1mm=0.2 Drawing Unitsبه صورت   1:200مثلا مقیاس 
تمام رنگ ها هنگام  all colors to black Forceکردن گزینهبا علامت دار 

  چاپ به رنگ سیاه تغییر رنگ میدهند.
  : براي درج اطلاعات اضافی در هر صـفحه هنگـام چـاپ میباشـد.     Stampدکمه 

درج نام ترسیم ، تاریخ و زمان ، نام وسیله چاپ ، اندازه کاغذ   این اطلاعات شامل
  و مقیاس میباشند .

  

  توسعه آرتمنطرح و 
www.irancivil.co.nr 
www.ksoft.ir 
info@ksoft.ir 
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